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ATTENTION: 

Installing the InertialExplorer software, you will be requested to register with WayPoint 
Inc. We strongly urge to do this, as only users that regiser will be notified of changes or 
updates to this version. If you miss the opportunity to register, then just reinstall the 
software. Otherwise, please monitor the ftp site ftp.waypnt.com with  

 username: inexplore 
 password: green0104apple 

ftp://inexplore:green0104apple@ftp.waypnt.com/Setup761     

for changes or updates. 

 

The package of delivery contains: 

 1 Reference Manual IE 7.7 
 1 Manual for using IE with iNAV or iVRU  
 1 CD with software IE 7.7 
 1 USB Software Protection Key  
 1 Software License Agreement 

 

Upgrade from a Demo Version to a full working versi on: 

Start the InertialExplorer Software: 

Start->Programs->Waypoint GPS->Utilities->Hardlock Upgrade Utility 

and type in the upgrade code you will get from the Waypoint support or the iMAR sup-
port: 

wpsupport@waypnt.com   sales@imar-navigation.de   

Before performing an upgrade, note the actual license number of your installation so 
you would be able to go one step back if required. 

Please note here the number of your hardlock key (dongle): 

 

Hardlock Key Number:  #xxxx   /   SYS xxxx.xxx 
You will be asked by our customer support before being able to provide any assistance.  
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1 Introduction 
The inertial measurement systems iNAV-FMS, iNAV-FJI, iNAV-RQH and iVRU-FAS are 
used for airborne surveying applications as SAR or LIDAR, vehicle motion analysis, atti-
tude control and supervision tasks. For detailed information please have a look to the 
documentation of our airborne laser scanning sys-
tems (iALS) being equipped with latest technology 
of most accurate laser or fiber optic gyros and high 
precision and ultra fast scanning laser scanners.  

The inertial measurement systems are additionally 
equipped with an odometer interface (“x pulses per 
meter” where x depends on the odometer) for 
road/rail applications and provide an interface for 
an external GPS receiver, if no internal GPS re-
ceiver is installed. 

Installation hints for integration of the iNAV-FMS, 
iNAV-RQH/FJI or the iVRU-xxx will be found in appendix A of this manual. 
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1.2 General Information 
Before starting any data acquisition it is required to survey all lever arms between IMS, 
GPS antenna and odometer accurately. All lever arms shall be measured within the co-
ordinate system of 
the IMS. Use the 
three markers on the 
top on the housing 
of the IMS (if there 
are any) or use the 
four outer screw 
heads on top of the 
cover of the INS to 
perform the most 
accurate surveying. 

The file format de-
scribed below can 
also be used to 
import inertial 
measurement data 
to iMAR’s post-processing software (beside of using the XIO dump file option). 
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2 Data Collection 
 

The iMAR navigation systems can save data in different binary formats. The format de-
pends on the used INS and on the software used during the data collection. 

1. Family of iMAR’s iNAV-FMS, iNAV-RQH, iNAV-FJI: Data can be stored on a 
separate notebook as an NavCommand file (data file format of NavCommand 
software) using iMAR’s software NavCommand. The NavCommand file format 
contains all raw data defined in the data storage definition section of this soft-
ware. The NavCommand data file can be post-processed without any conversion 
with the InertialExplorer software. The data transmission between INS and note-
book is via Ethernet TCP/IP. 

2. Family of iMAR’s iNAV-FMS, iNAV-RQH, iNAV-FJI: Data can be stored on a 
separate notebook as an XIO-DUMP-File using iMAR’s software NavCommand. 
The DUMP file contains all data defined in the data storage definition section of 
this software and additionally all internal generated signal/error/warning informa-
tion. The DUMP file has to be converted before processing into the NavCom-
mand file format with iMAR’s software ReadXioFile.exe. The data transmission 
between INS and notebook is via Ethernet TCP/IP. 

3. Family of iMAR’s iNAV-FMS, iNAV-RQH, iNAV-FJI: Same as described in sec-
tion 2, but the DUMP file will be stored autonomous on the internal flash-drive of 
the INS. The DUMP file contains all data defined in the data definition script 
which is located in the root directory of the INS file system. This operation is the 
recommended operational use of the INS (also for using iMAR’s post-proc soft-
ware). The DUMP file has to be converted before processing into the NavCom-
mand file format with iMAR’s software ReadXioFile.exe. The data transmission 
between INS and notebook is via Ethernet TCP/IP. 

4. Family of iMAR’s iVRU-xxx: Data are transmitted via RS232 and can be stored 
on a separate notebook using a terminal program. The data format is binary and 
has to be converted to the NavCommand file format before starting the post 
processing procedure with the InertialExplorer software. 

 

Chapter 2.1 describes the data collection for systems of the family iNAV, chapter 2.2 
describes the data collection of systems of the family iVRU. 

2.1 Data Collection for iNAV Systems 
For data collection there are four ways to do this job: 

a) The raw data can all be stored on the notebook where the NavCommand Software is 
running. In this case the data to be logged are defined in the NavCommand / Con-
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figuration / Data_Storing menu and then all data are transmitted via TCP/IP Ethernet 
from the IMS to the Notebook. The settings being required are described in chapter 
2.1.1 for storing the data in a dedicated data file.  

b) The settings being required to store all XIO data information via Nav_Command in a 
dump file on the 
Notebook 
(transmission 
via TCP/IP as 
in a) described 
above) are 
described in 
chapter 2.1.2 

c) The data can 
also be stored 
on the 
notebook using 
the 
XIO4Windows 
software. This 
software will not 
change any 
settings on the 
IMS by its own 
(of course all 
parameters can 
be changed 
also with this 
software) and 
allows 
generating data 
logs which are 
written into a 
XIO-dump-file on the notebook. See chapter 2.1.4 

d) The raw data can also be stored on the flash disk of the IMS (if there is any flash 
disk for data storing with a capacity of at least 2 GByte installed). For this a control 
script file has to be present on the IMS which defines which data shall be stored on 
the IMS integrated dump file. Additionally some data can be stored on the Notebook. 
See chapter 2.1.3 

 

2.1.1 Raw data on Notebook in a Standard File Forma t  

�  First the INS shall be connected to the GPS receiver (NMEA sequences GGA, VTG, 
GST, 1 Hz, and PPS). Make sure, that the INS is set to “external GPS” if an external 
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GPS engine is used (see hardware manual). Then the INS must be connected to the 
odometer (for road or rail applications only) where it is recommended to mount it on a 
non-driven and non-braked wheel (if any) and to use a device which also provides the 
direction of motion (forward/backward) . This can be an incremental encoder or an 
iMWS (magnetic wheel sensor). 

�  Apply your GPS base station and start data acquisition at least 30 minutes before 
starting the surveying with the INS. Raw data shall be acquired in a way that it is possi-
ble afterwards to generate a data file in RINEX format or in a receiver propriety format 
which is supported by the post-processing software (see chapter 5). Store the data on a 
separate base PC / notebook. Use a data rate of at least 1 Hz. 

�  Apply your GPS rover station to the INS and configure the output on serial port #1 of 
the GPS receiver to 19200 Bd (8 N 1) and adjust the GPS receiver to send at least the 
NMEA messages GGA, VTG, GST (position/time, velocity/track, standard deviation of 
GPS data). The second port #2 of the GPS receiver shall send the GPS raw data and 
shall be stored on a separate mobile PC (or on the PC which is used to run Nav_Com-
mand software). Also these raw data shall be in RINEX format or a receiver propriety 
format which is supported by the post-processing software. 

�  Then the mobile PC / notebook will be connected to the INS via an Ethernet cross-
over cable. Apply power to the INS and start the software NavCommand (see separate 
manual). 

For the iNAV-FMS systems for airborne applications (without  odometer) select the 
time-triggered logs in binary format (in this sequence!): 

·  TMOD (Time model result, contains UTC time in seconds after UTC  
  midnight, sec) 

·  IACC  (acceleration, including gravity, m/s²) 

·  IOMG  (angular rate, including earth rate, rad/s) 

·  RAWVX (velocity measured from the odometer [if any], m/s) 

·  [NRPY] (RPY angles, in rad,  calculated in real-time from the INS;  
  these angles will not used in post processing butt they are useful to 
  check the results. It is not necessary to have NRPY available in the 
  data set) 

·  [ExtGPSVEL] GPS Velocity and standard deviation (if any) 

·  [ExtGPSPOS] GPS Position and standard deviations 

for data storing on file. 

For the iNAV-FMS systems for surface applications (with odo meter) select the time-
triggered logs in binary format (in this sequence!): 

·  TMOD (Time model result, contains UTC time in seconds after UTC  
  midnight, sec) 
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·  IACC  (acceleration, including gravity, m/s²) 

·  IOMG  (angular rate, including earth rate, rad/s) 

·  RODO (distance [m]; velocity measured from the odometer [if any] 
   = RODO/ODOT, m/s) 

·  ODOT  (time [s]; velocity measured from the odometer [if any] 
   = RODO/ODOT, m/s) 

·   [NRPY] (RPY angles, in rad,  calculated in real-time from the INS;  
  these angles will not used in post processing butt they are useful to 
  check the results. It is not necessary to have NRPY available in the 
  data set) 

·  [ExtGPSVEL] GPS Velocity and standard deviation (if any) 

·  [ExtGPSPOS] GPS Position and standard deviations 

for data storing on file. 

For the iNAV-RQH/FJI systems for airborne applications (wit hout odometer) select 
the time-triggered logs in binary format (in this sequence!): 

·  TINTRPL (Time model result, contains UTC time in seconds after UTC  
  midnight, sec) 

·  TIME  (IMU Time since IMU power-on, sec; usefull for time validation) 

·  IACC  (acceleration, including gravity, m/s²) 

·  IOMG  (angular rate, including earth rate, rad/s) 

·  [NRPY] (RPY angles, in rad,  calculated in real-time from the INS;  
  these angles will not used in post processing butt they are useful to 
  check the results. It is not necessary to have NRPY available in the 
  data set) 

·  [ExtGPSVEL] GPS Velocity and standard deviation (if any) 

·  [ExtGPSPOS] GPS Position and standard deviations 

for data storing on file. 

For the iNAV-RQH/FJI systems for surface applications (with  odometer) select the 
time-triggered logs in binary format (in this sequence!): 

·  TINTRPL (Time model result, contains UTC time in seconds after UTC  
  midnight, sec) 

·  TIME  (IMU Time since IMU power-on, sec; usefull for time validation) 

·  IACC  (acceleration, including gravity, m/s²) 

·  IOMG  (angular rate, including earth rate, rad/s) 
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·  RODO1 (distance [m]; velocity measured from the odometer [if any] 
   = RODO/ODOT, m/s) 

·  ODOT  (time [s]; velocity measured from the odometer [if any] 
   = RODO/ODOT, m/s) 

·   [NRPY] (RPY angles, in rad,  calculated in real-time from the INS;  
  these angles will not used in post processing butt they are useful to 
  check the results. It is not necessary to have NRPY available in the 
  data set) 

·  [ExtGPSVEL] GPS Velocity and standard deviation (if any) 

·  [ExtGPSPOS] GPS Position and standard deviations 

for data storing on file. 

 

The postprocessing software can handle the time logs “TINTRPL” and “TMOD”, the log 
“TIME” is only used for validation of time stamp data and is not mandatory. 

 

Choose “binary” data format and  

�  “200 Hz” storing frequency for iNAV-FMS IMS type or  

�  “2000 Hz” for laser gyro 
based systems of type 
iNAV-RQH or 

�  “1000 Hz” for fiber optic 
gyro based systems of 
type iNAV-FJI or 

�  “200 Hz” for fiber optic 
gyro based systems of 
type iVRU-Fxx.  

 

Using a NAV-FMS or NAV-RQH 
or NAV-FJI  IMU the external 
trigger settings in the FMS page 
should be set to hard trigger 
and PPS mode (PPS must be 
available to start collecting the 
data). Using “hard trigger” the 
IMU starts data acquisition not before the first time it has seen valid GPS for 100 
                                            
1  If you use the log “RAWVX” instead of “RODO” and “ODOT”, the postprocessing has to be able to 
process distance incremens (d = RAWVX * dT). “RODO” and “ODOT” are preferred measurements. 
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seconds (after the IMU gets GPS first time, the internal time model is calculated over 
100 seconds [depends on settings] and after this the data are available and the 
measurement / data storing can be started). The correct time model acquisition can be 
observed by the TMOD LED on the main screen of Nav_Command, which will become 
green if the time model has been detected to be stable due to GPS / PPS input. 
Furthermore in the data storing menu as time base TMOD shall be selected. 

The ENU/NED button in the main screen has only influence on the displayed data and 
does not affect the data storing. 

 

Furthermore to use also iMAR’s Kalman filter post processing software, the XIO Dump 
File shall be stored via TCP/IP on the user’s laptop or on an optional internal Flash Disk 
on the IMU (only available for the 32 bit IMS software). 

Additional data can be stored if desired (e.g. online navigation solution).  

For time tag choose GPS time as “UTC second of day” (i.e. since midnight). 

The [GPSVEL / GPSPOS] data are not used for the post-processing. They are only rec-
ommended to be logged by Nav_Command software as a rough check of motion. 

 

�  Wait until you 
have first contact 
to valid GPS 
data (GPS LED 
will change to 
yellow [no differ-
ential mode] or 
green [differen-
tial correction 
data available]) 
and the IMS time 
is synchronized 
with the GPS 
time (this will 
take about 2 
minutes) and 
then start driving 
until the track 
LED will indicate 
a valid track an-
gle. 

�  Now start the data storing on hard disk of your laptop with key F3 (start measure-
ment). Option: Storing of data on internal flash drive – starts automatically after power-
on. 
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You can also start data storing immediately, but then the online solution may be wrong 
until the initial track is calculated the first time (but this has no influence on the post-
processing performance). 

�  Now perform your measurements. If you operate a land vehicle and if there are a lot 
of GPS outages, it is recommended to stop the vehicle all some minutes to perform a 
so-called zero-velocity update (ZUPT) which will help the post-proc software to improve 
the results significantly. If no odometer is used, it is helpful to indicate the ZUPT se-
quence with an input to the NavCommand software to allow the post processing a better 
standstill (ZUPT) analysis. 

�  It i required to continue data acquisition on the end position at standstill (end of mis-
sion) for  

�  at least 10 minutes for the high-end navigation systems (iNAV-RQH/FJI) 

�  3 minutes for the medium grade systems (iNAV-FMS) and 

�  1 minute for the lower performance systems (iVRU-Fxx, iVRU-Sxx). 

At the end of the surveying stop the measurement / data acquisition  (press F3).  

The data format of the result files is described in chapter 4. 

 

2.1.2 Generating a Dump file on Notebook or IMS Fla sh Disk  

2.1.2.1 Dump file on Notebook  

The same data as described in chapter 2.1 can be stored in a dump file where all data 
are stored in the XIO data format. 

To do this, the corresponding features have to be selected: 
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2.1.2 Dump file on IMS internal flash disk  

The same data as described in chapter 2.1 can be stored in a dump file inside of the 
IMS (if a separate data flash disk is available) where all data are stored in the XIO data 
format. 
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First the file name will be defined. In the shown screen dump example (see picture 
above), the file name is incremented with every new start of the system. Furthermore 
elder files are deleted automatically if their size is smaller than 50 MByte (be carefully 
with this option, because it deletes small files without any condition!). Then you can se-
lect the script file which shall be used and it can be defined whether only the logs de-
fined in this script file shall be stored in the XIO dump file or if also all logs being acti-
vated by Nav_Command shall be stored in the same file. 

An example of the script file, which activates the system to store the logs TIME, TMOD, 
IACC, IOMG and the external values ExtValGpsPos, ExtValGpsVel, ExtValGpsUTC is 
shown in the following: 
lgact 0 0 0.0 
*Delay 10000 
autox 0 1 
autox 1 1 
autox 5 1 
; airborne applications (logging at 2000 Hz) 
log 0 2000.0 TIME TMOD IACC IOMG 
; land vehicle applications (with odometer, logging  at 2000 Hz) 
; log 0 2000.0 TINTRPL TIME IACC IOMG RODO ODOT 
*Trigger 
 

Please pay attention to the following:  
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a) The dump file on the IMS file system is opened automatically with any power-on of 
the system. It must be closed before power-down! If you close the Nav_Command 
application, the dump file is closed automatically (or type the command DUMP “” in 
XIO4WIN to close the file). If the IMS is powered down while the dump file is still 
open, the flash disk can be damaged (at least new formatting is required). 

b) Before starting a measurement where a dump file is written on the internal flash disk, 
it is required to format the flash disk to ensure that the data can be written on the 
disk with highest data rate without any additional delay. Writing on a fragmented disk 
causes a blocking of the write procedure of the IMS and will lead to significant loss 
of data! The formatting of the disk can be done via iMonLog software (it can also be 
done using the iMonTerm software via RS232). 

 

2.1.3 Dump file on the user notebook’s hard disk vi a XIO4Windows 

The same data as described in chapter 2.3 can be stored in a dump file outside of the 
IMS using the software XIO4Windows.exe. This software is an iMAR internal develop-
ment and maintenance software and allows an access to the IMS on low level base. 
The advantage of this method is that the settings on the IMS will not be changed (using 
Nav_Command, the IMS is automatically configured by Nav_Command to be able to 
support all features of this software – this may cause that internal settings like CAN pa-
rameters will be changed if Nav_Command is not started in transparent mode).  

·  Start XIO4Windows.exe corresponding to the XIO4Windows manual, i.e. select 
TCP/IP mode, insert the IP address of the IMS (standard TCP/IP address in a 
point-to-point connection is 192.168.1.199 or 192.168.1.198; port number is 
50052) and press the “OK” button or insert the logical name (e.g. 0181_001) if 
there is a DHCP server in the network and press “Locate Host” to connect the 
IMS with your notebook. 

·  Now select the file selection button of “all XIO data” and create/select a file which 
is used to store all raw data (see red arrow in the screen shot). 

·  Now activate all data logs which are required for post-processing by loading the 
script which contains all commands to activate the data TIME, TMOD, IACC, 
IOMG and the external values ExtValGpsPos, ExtValGpsVel, ExtValGpsUtc and 
ExtValGpsHdt (see green arrow in the screen shot). Additional select the 
XIO_ID_EXTVAL -> HDT (see second screen shot). 

Now all data are stored in the dump file. To stop data storing send the command EXW 0 
0 from the XIO4Windows command line (to close all files on the IMS flash drive) and 
afterwards press the OK button in the right lower corner of the XIO4Windos software. 
Now wait at least 20 seconds before switching the power off.  

An example of the script file, which activates the system to store the logs TIME, TMOD, 
IACC, IOMG with 200 Hz and the external values ExtValGpsPos, ExtValGpsVel, 
ExtValGpsUTC is shown in the following: 
autox 0 1 
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autox 1 1 
autox 5 1 
;autox 11 1 
; airborne applications (logging at 200 Hz) 
log 0 200.0 TIME TMOD IACC IOMG 
; land vehicle applications (with odometer, logging  at 200 Hz) 
; log 0 200.0 TINTRPL TIME IACC IOMG RODO ODOT 
 

 

An example of the script file, which activates the system to store the logs TIME, TMOD, 
IACC, IOMG, RAWVX (RAWVX is the velocity measured in vehicle’s x direction from an 
odometer) with 200 Hz and the external values ExtValGpsPos, ExtValGpsVel, 
ExtValGpsUTC is shown in the following: 
autox 0 1 
autox 1 1 
autox 5 1 
;autox 11 1 
; airborne applications (logging at 200 Hz) 
; log 0 200.0 TIME TMOD IACC IOMG 
; land vehicle applications (with odometer, logging  at 200 Hz) 
log 0 200.0 TINTRPL TIME IACC IOMG RODO ODOT 
 

 

An example of the script file, which activates the system to store the logs TIME, TMOD, 
IACC, IOMG, RVEL3 (RVEL3 is the velocity measured in vehicle’s x direction from three 
odometers, e.g. used in pipeline surveying) with 1000 Hz and the external values 
ExtValGpsPos, ExtValGpsVel, ExtValGpsUTC is shown in the following: 
autox 0 1 
autox 1 1 
autox 5 1 
;autox 11 1 
log 0 1000.0 TIME TMOD IACC IOMG RVEL3 
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2.1.4 Converting a DUMP-File to a NavCommand-File  

Using the ReadXioFile.exe software the Dump-File can be converted to a file according 
to the NavCommand structure. Start the ReadXioFile.exe software and use the follow-
ing settings (details can be found in the ReadXioFile.exe manual): 

1. Select the input file *.DMP 

2. Check “Validate Inertial Data” and choose log number 0000 
(the number depends on the used script and can be determined by checking the 
box “create data logs” where the filename contains the log number of the XIO 
data log; for iNAV-FMS hardware the log number may be 1003). 

3. Check the box “Extended inertial log TIME TMOD IACC IOMG” (NAV-FMS, 
airborne) or TINTRPL TIME IACC IOMG (NAV-RQH/FJI) depending on the logs 
you have selected to be stored on file during the measurement periode.  

4. Check the box “Create NavCommand compatible inertial data file” 

5. Start the data conversion with “ok” 

 

The result of this conversion is a file *.DAT which contains the required data in binary 
format. The header of this file is in text format (see chapter 4). 

If the data are already stored in the NavCommand file format, this conversion has not to 
be performed. 
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2.2 Converting Data from an iVRU-xx into NavCommand  Format and 
afterwards into iWP+ Format 
The data acquired by the iVRU-xx are stored on the user’s notebook / PC via RS232 
using a terminal software like the iMTTTY Terminal. It is recommended to use a 
USB/RS232 adapter to perform highest data rate on the RS232 (115.2 kBd) under Win-
dows. The iVRU data transmission settings shall be  

 rs232 mode 2051 FFFF 

to ensure that the calibrated raw data of gyros and accelerometers as well as the time 
stamp is transmitted in binary format. 

Once the data have been acquired, use the converter software 
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 FILT.exe   *.VRU >  *.log 

The software FILT.exe has to be started in a Command box (DOS-Box). The file *.VRU 
is the file which has been acquired by the terminal software via RS232. The *.log file will 
contain error messages if there are any during the conversion process. The result of 
conversion is two files: 

 *.DAT  this file contains the data in the binary format according to the  
   NavCommand standard 
 *.ASC  this file contains the data in the text format according to the  
   NavCommand standard 

The log file looks like: 
Counter   AX       AY      AZ        GX       GY       GZ      internal use only 
    3  -0.0219  -0.0110  +9.7980   +0.014   +0.020   +0.008    5302400       5003 
    4  -0.0159  -0.0217  +9.8004   +0.002   +0.003   +0.009    5302400      11684 
    5  -0.0117  -0.0110  +9.7989   +0.012   -0.001   +0.028    5302400      18369 
    6  -0.0182  -0.0172  +9.7939   +0.007   +0.013   +0.007    5302400      25047 
    7  -0.0101  -0.0156  +9.8056   +0.018   +0.020   -0.007    5302400      32381 
    8  -0.0113  -0.0091  +9.7973   +0.001   +0.004   +0.025    5302400      38413 

 

The ASC file looks like: 
# GPSVel - Data Logfile from iMAR VRU 
# Started... 
# Column 1: Marker (1 x 4 byte int) 
# Column 2: TMOD, UTC_time[s], Col = 1.0 * value - 0.0, (8 byte double) 
# Column 3: IACC, IACC_X [m/s/s], Col = 1.0 * value  - 0.0, (8 byte double) 
# Column 4: IACC, IACC_Y [m/s/s], Col = 1.0 * value  - 0.0, (8 byte double) 
# Column 5: IACC, IACC_Z [m/s/s], Col = 1.0 * value  - 0.0, (8 byte double) 
# Column 6: IOMG, IOMG_X [m/s/s], Col = 1.0 * value  - 0.0, (8 byte double) 
# Column 7: IOMG, IOMG_Y [m/s/s], Col = 1.0 * value  - 0.0, (8 byte double) 
# Column 8: IOMG, IOMG_Z [m/s/s], Col = 1.0 * value  - 0.0, (8 byte double) 
0000   53024.005  -0.0219  -0.0110   9.7980   +0.01 4   +0.020   +0.008 
0000   53024.012  -0.0159  -0.0217   9.8004   +0.00 2   +0.003   +0.009 
0000   53024.018  -0.0117  -0.0110   9.7989   +0.01 2   -0.001   +0.028 
0000   53024.025  -0.0182  -0.0172   9.7939   +0.00 7   +0.013   +0.007 
0000   53024.032  -0.0101  -0.0156   9.8056   +0.01 8   +0.020   -0.007 
 
Mark   UTC SOD    AX       AY        AZ       GX       GY       GZ 
 
SOD = Second Of Day 

 

Please use the file *.DAT as described in the following chapters. 

The screenshot of data conversion from *.DAT to *.IMR within the iWP+ software has to 
be set as follows (if the iVRU-FAS has sent data with 150 Hz): 
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The 13 seconds is the number of leap seconds at the date of data acquisition (attention: 
the number of leap seconds will be increased to 14 at January 1, 2006!). 
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Type the date of the day when the data had been acquired.  

 

At the end of conversion you get the following screen: 
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The Output ASCII file looks like: 
GPS SOW     GX         GY        GZ        AX       AY         AZ 
398637.005  -0.01991   0.01362   0.00797   0.01105  -0.02189   9.79801 
398637.012  -0.00322   0.00161   0.00919   0.02169  -0.01592   9.80042 
398637.018   0.00084   0.01213   0.02807   0.01099  -0.01168   9.79893 
398637.025  -0.01273   0.00670   0.00681   0.01715  -0.01818   9.79391 
398637.032  -0.01955   0.01798  -0.00703   0.01561  -0.01008   9.80558 
398637.038  -0.00412   0.00067   0.02461   0.00908  -0.01125   9.79730 
 
SOW  =  Second Of Week 

 

 

3 File Format of NavCommand Data Files 
The file produced by the iNAV-Command software is containing the INS data in the fol-
lowing data format and can be written in text or binary format (the header always is in 
text format! The text can be in English or German language, the keywords like IACC, 
NRPY etc. are always the same). The header may contain the UTC time and date, but it 
may be that those details not available. The TMOD value in the data sets contains the 
UTC seconds of day (if the measurement continues over midnight, the time does not 
jump back to zero!). The number of entries (number of columns in text file or number of 
values/bytes per sample) depends on the application. Furthermore the series of entries 
may change). The header in the binary file has a “end-of-header” information: 

 
# GPSVel - Data Logfile from iMAR NavCommand (XIO) Vers. 3.13 (05.04.2003) 
# Started: 04/06/2003  19:24:09 (local) 04/06/2003  17:24:09 (UTC) 
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# Column 1: Marker (1 x 4 byte int) 
# Column 2: TMOD, UTC_time [s], Col = 1.0 * value -  0.0, (8 byte double) 
# Column 3: IACC, IACC_X [m/s/s], Col = 1.0 * value  - 0.0, (8 byte double) 
# Column 4: IACC, IACC_Y [m/s/s], Col = 1.0 * value  - 0.0, (8 byte double) 
# Column 5: IACC, IACC_Z [m/s/s], Col = 1.0 * value  - 0.0, (8 byte double) 
# Column 6: IOMG, IOMG_X [°/s], Col = 1.0 * value -  0.0, (8 byte double) 
# Column 7: IOMG, IOMG_Y [°/s], Col = 1.0 * value -  0.0, (8 byte double) 
# Column 8: IOMG, IOMG_Z [°/s], Col = 1.0 * value -  0.0, (8 byte double) 
# Column 9: RAWVX, RAWVX [m/s], Col = 1.0 * value -  0.0, (8 byte double) 2 
# Column 10: NRPY, Roll  [°], Col = 1.0 * value - 0 .0, (4 byte double) 
# Column 11: NRPY, Pitch [°], Col = 1.0 * value - 0 .0, (4 byte double) 
# Column 12: NRPY, Yaw   [°], Col = 1.0 * value - 0 .0, (4 byte double) 
 
0000   739.7300 -5.6667059E-002 -2.8010763E-002  8. 6376097E-003 -2.0083377E-002 -4.7732625E-002  
8.7552518E-002 1.02034534E-003 -1.5496261E+000 -3.6 764326E+000 -1.5441850E+002  
0000   739.7350 -5.6567654E-002 -2.7654063E-002  8. 3453324E-003 -4.8625745E-002 -4.5485637E-002  
8.2653279E-002 2.36453086E-003 -1.5585432E+000 -3.6 855643E+000 -1.5438945E+002  
0000   739.7400 -5.6463458E-002 -2.5674563E-002  7. 6324653E-003 -5.7544523E-002 -4.2356345E-002  
7.8667878E-002 2.87656456E-003 -1.5678756E+000 -3.6 987656E+000 -1.5434565E+002  
 
The text data are in m/s², m/s, deg, deg/s etc. 

ATTENTION: The postproc software can handle only files which are stored in the binary 
format (do not store those data in NavCommand in text format)!  

If the data are stored in binary format, the header is the same but then the data are fol-
lowing with the size described in the header. The data example above given shows the 
file stored in text mode. In text mode each line (data of 1 sample) is closed by a <line 
feed> or by a <carriage-return><line feed>. 

Additional in binary mode data can be included in the file so the data extraction module 
has to parse the required data sets. 

If the data are stored as a XIO dump file, a special tool is available to separate the dif-
ferent values. See the manual for the ReadXioFile software. 

 

Example of a binary data file (here in German language): 

 
# IMS - Daten Logdatei von iMAR NavCommand (XIO) Ve rs. 3.41 (30.01.2005) 
# Gestartet: 01/31/2005  12:26:20 (lokal) 01/31/200 5  11:26:20 (UTC) 
# Spalte  1: Marker,                                                           (4 byte int) 
# Spalte  2: TMOD, UTC_time [     s], Spalte = 1.00 0000 * Messwert - 0.000000, (8 byte double) 
# Spalte  3: IACC,   IAcc_X [  m/s²], Spalte = 1.00 0000 * Messwert - 0.000000, (8 byte double) 
# Spalte  4: IACC,   IAcc_Y [  m/s²], Spalte = 1.00 0000 * Messwert - 0.000000, (8 byte double) 
# Spalte  5: IACC,   IAcc_Z [  m/s²], Spalte = 1.00 0000 * Messwert - 0.000000, (8 byte double) 
# Spalte  6: IOMG,   IOmg_X [ rad/s], Spalte = 1.00 0000 * Messwert - 0.000000, (8 byte double) 
# Spalte  7: IOMG,   IOmg_Y [ rad/s], Spalte = 1.00 0000 * Messwert - 0.000000, (8 byte double) 
# Spalte  8: IOMG,   IOmg_Z [ rad/s], Spalte = 1.00 0000 * Messwert - 0.000000, (8 byte double) 
# Sync_byte = 0x81, Sync_length =  4, Sync_period =   100, Header_terminator = 0x1A 
 

                                            
2 If three odometers are used, the log to be used is RVEL3 instead of RAWVX. It contains 3 values 
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The binary data are in m/s², m/s, rad, rad/s etc. 

All N data samples a SYNC period is inserted in the file. In the above example it is 4 
sync bytes all 100 samples. The header is terminated by a header terminator. 

 

It may happen that beside of the TMOD (UTC-time) also the TIME (IMU-time) is stored 
in the file. The most common data logs are: 

MARKER, TIME, TMOD, IACC, IOMG, NRPY, RAWVX, RVEL3  

 

The above described binary NavCommand file format is used by the postproc software 
InertialExplorer. 

 

Appendix: File format for surface applications (with odometer): 

 
# IMS - data log file from CNavCommandApp 0003.0044 .0052 build Aug 15 2006 18:29:58 
# Started: 09/24/2006  13:20:59 (local) 09/24/2006  11:20:59 (UTC) 
# Column  1:  Marker,                                                                      (4 
byte int) 
# Column  2:  TINTRPL, TINTRPL, [     s], Col = 1.0 00000 * Mea - 0.000000, (8 byte double) 
# Column  3:  TIME,   IMS_time, [     s], Col = 1.0 00000 * Mea - 0.000000, (8 byte double) 
# Column  4:  IACC,     IAcc_X, [  m/s²], Col = 1.0 00000 * Mea - 0.000000, (8 byte double) 
# Column  5:  IACC,     IAcc_Y, [  m/s²], Col = 1.0 00000 * Mea - 0.000000, (8 byte double) 
# Column  6:  IACC,     IAcc_Z, [  m/s²], Col = 1.0 00000 * Mea - 0.000000, (8 byte double) 
# Column  7:  IOMG,     IOmg_X, [ rad/s], Col = 1.0 00000 * Mea - 0.000000, (8 byte double) 
# Column  8:  IOMG,     IOmg_Y, [ rad/s], Col = 1.0 00000 * Mea - 0.000000, (8 byte double) 
# Column  9:  IOMG,     IOmg_Z, [ rad/s], Col = 1.0 00000 * Mea - 0.000000, (8 byte double) 
# Column 10:  RODO,    RawOdo0, [     m], Col = 1.0 00000 * Mea - 0.000000, (8 byte double) 
# Column 11:  ODOT,       OdoT, [     s], Col = 1.0 00000 * Mea - 0.000000, (8 byte double) 
# Column 12:  RAWVX,     RawVX, [   m/s], Col = 1.0 00000 * Mea - 0.000000, (4 byte float) 
# Column 13:  NRPY,       roll, [   rad], Col = 1.0 00000 * Mea - 0.000000, (4 byte float) 
# Column 14:  NRPY,      pitch, [   rad], Col = 1.0 00000 * Mea - 0.000000, (4 byte float) 
# Column 15:  NRPY,        yaw, [   rad], Col = 1.0 00000 * Mea - 0.000000, (4 byte float) 
# Sync_byte = 0x81, Sync_length =  4, Sync_period =   100, Header_terminator = 0x1A 

 

Actual velocity, obtained by the odometer, is calculated by v_odo = RODO/ODOT 

If no odometer count has been obtained within the last IMU sample, both values (RODO 
and ODOT) are zero because no actual velocity can be calculated in this case.The user 
has to decide after which timeout he will decide that the vehicle has “zero velocity” (zero 
velocity means n odometer pulse and therefore the denominator ODOT is infinite, i.e. 
infinite waiting for the next odometer pulse is equal to zero velocity).  
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4 Data Conversion from NavCommand to InertialExplor er 
 and Data Processing 
In the following chapter the following steps of processing are described: 

�  Take the GPS data from the rover (mobile) and from the base (master) station and 
load them into the InertialExplorer.  

�  Perform the post-processing with the InertialExplorer software or use the DGPS post 
processed data and use the iMAR post processing tool.  

 

Copy the files user.imu, manufact.imu, user.cim and manufact.cim from your CD into 
the main directory of your InertialExplorer (iWP+) installation. Those files contain the 
settings of the IMU for data conversion and filtering. 

 

1. Convert the DUMP file to NavCmd file format *.DAT (use ReadXioFile.exe, see 
chapter 2.2.6). 

2. Read the  *.DAT file 
(NavCommand format) into 
the InertialExplorer 
postproc software as 
described in the following: 

 

·  Open the IE software 
and select the  
 File->Convert->Raw 
IMU Data to Waypoint 
Generic (IMR) 

·  Select the iMAR profile 
and select the NavCom-
mand file *.DAT 
 

·  choose “Modify” and ad-
just the data rate if nec-
essary 

·  Choose the right sensor 
orientation. (see next 
page) 
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·  Select the right decoder to decode iMAR data (very important!) 
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·  Now, after having done all described settings, start the data conversion with 
“Convert”. This can take several minutes, depending on the size of the data 
file. 
You will see the following screen: 
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Check the Output ASCII file if you are not sure that you are on the right way: 
The Output ASCII file looks like (if z is directed up and INS is at standstil): 
GPS SOW     GX         GY        GZ        AX       AY         AZ 
398637.005  -0.01991   0.01362   0.00797   0.01105  -0.02189   9.79801 
398637.012  -0.00322   0.00161   0.00919   0.02169  -0.01592   9.80042 
398637.018   0.00084   0.01213   0.02807   0.01099  -0.01168   9.79893 
398637.025  -0.01273   0.00670   0.00681   0.01715  -0.01818   9.79391 
398637.032  -0.01955   0.01798  -0.00703   0.01561  -0.01008   9.80558 
398637.038  -0.00412   0.00067   0.02461   0.00908  -0.01125   9.79730 
 
SOW  =  Second Of Week 

 
 

3. In the InertialExplorer: Import the GPS files (see also the IE manual): 
a) Convert all files of the GPS master station to GPB format:  
    File->Convert->RawGPS-to-PB 
    Choose the option “re-calculate position” otherwise it is not possible 
    to determine the initial position of the master station from the data itself! 
b) Combine the files of the GPS master station with  
    Files->GPB-Utils->Concatenate 
    to one master file (if several files are used) 
c) load the master file with File->Add-Master-Files 
d) convert the rover file (remote) to GPB format:  
    File->Convert->RawGPS-to-GPB 
e) convert the Remote File from static mode into kinematic mode:  
    View->GPSobservations-> master/remote->ViewRawDataGPS->Edit->F6   
and select “kinematic” 
f) load the rover file (remote) with File->Add-Remote-File 

4. First process GPS data in GrafNav: Process->GPS-Differential 
�  If no master station data are available, for a quick-look it is possible to view 
the GPS data without DGPS correction: load the rover data and perform “Proc-
ess->Process Single GPS Point” 

5. Now import the INS data: Go to Settings->IMU Settings->General and insert the 
name of the Raw Inertial Measurement file (*.imr).  
Note: In the future version iWP+ 7.6 the INS file import is done directly from  File-
>Add IMU-File (where you also load the GPS files). 

6. Set the IMU processing settings: Settings->IMU-Settings. Select an iMAR profile 
or create your own processing profile. Read the manual carefully to understand 
the processing procedure. A special user setting configuration file user.imu is 
available from iMAR and must be copied into the root directory of the iWP+ in-
stallation (if you have created your own user settings, you have to merge both 
files with an editor (it is a text file)). 
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7. Process DGPS/INS data: Process->IMU (first perform a forward calculation, 
afterwards perform a reverse calculation). Be aware that the parameters of for-
ward and backward calculation can be set independently. 

8. Combine INS/GPS: Process->Combine-Solution->IMU-forward-and-reverse 
to create the output plots for separations. 
To reduce the computation duration for the combine process, use the function 
    Process->Combine-Solution->any two solutions   
and select the FIM and RIM files (in this case the 1 Hz data are used instead of 
the 2000 Hz data) 

9. Plot the results: Output->Plot-INS/GPS->IMU-> 
- INS/GPS-Position-Misclosure: INS – DGPS difference 
- INS/GPS-Veloc-Misclosure: INS – DGPS difference 
- ... 
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5 File Format of DGPS Raw Data 
The raw data of the GPS rover station and GPS base station (reference receiver) are 
required. It is recommended to start the base station at least half an hour before per-
forming the measurement.  

5.1 Javad Receiver 
Using a JAVAD receiver, the following setting is recommended: 

On the rover (for raw data for post-processing and NMEA data for real-time calculation) 
 
set,dev/ser/a/rate,115200  ; to connect PCView (jav ad) 
set,dev/ser/b/rate,19200  ; to connect iNAV-FMS 
set,/par/nmea/gp,on   ; NMEA 
em,/dev/ser/b,nmea/GGA   ; NMEA 
em,/dev/ser/b,nmea/VTG 
em,/dev/ser/b,nmea/GST 
#em,/dev/ser/b,nmea/HDT   ; only for true heading ( 2 antenna GPS) 
em,/dev/ser/a,def:1     ; Javad-raw-data with 1 sec  data rate 
 

On the base station (for raw data for post-processing): 
 
set,dev/ser/a/rate,115200  ; to connect PCView (Jav ad) 
em,/dev/ser/a,def:1     ; Javad raw data (data all 1 sec)  
 

Following wiring is recommended for using a laptop for both rover and base station. 

Laptop_Rover:   - Connect the iNAV System via Ethernet / TCP/IP 
   - Connect the Javad GPS receiver (port b) to an USB2RS232 
     converter connected to the laptop 
   - Connect the Javad GPS receiver (port a) to the COM2 input  
     of the iNAV system 

Laptop_Base: - Connect the Javad GPS receiver (port a) to the COM1 of the 
     laptop. 

Using the Javad software PCVIEW.EXE on both base and rover laptop to collect the 
GPS data required for the post-processing, it is not required to initialise the receivers to 
send raw data, but it is important to initialise the receivers to calculate the GPS solution 
with sufficient data rate (e.g. 10 Hz). 
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Connect to the receiver, open the “File” menu and select the “Save to File” option.  

Do not use the WLOG software for Javad receivers, because that does not handle the 
GLONASS like the PCView software provided by Javad. 

 

5.2 NovAtel Receiver 
For the NovAtel OEM4-G2-L1/L2 receiver use the WLOG software included in the Iner-
tialExplorer package and select following messages: 

RANGECMPB ONTIME 0.05 (if data shall be sampled wit h 20 Hz) 
RAWEPHEMB ONCHANGE 

 

5.3 Reference Data 
It is highly recommended to use one’s own GPS reference station. If this is not possible, 
you may try to download such data from your closest public station from the Internet. 
This can also be helpful if your reference station had not been configured to acquire 
proper ephemerides data.  

In the iWP+ software you find a download tool which allows to search for the next 
reference station (IGS, EuroRef etc.) and to download the data. Remember that those 
data on the Internet may be available with a delay of more than 24 hours and mostly at 
update rates of only 10...15 seconds. 
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6 Time Format 
The data of the INS are stored in UTC, but in second of day (SOD) instead of second of 
week. So to calculate the second of week (SOW), the following equation shall be used: 
 INS_Time (UTC SOW) = INS_Time (UTC SOD) + Day*24*3 600 [seconds] 
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where   
 
 Day     =  (0 for Sunday, 1 for Monday, 2 for Tuesday,  
    3 for Wednesday,...., 6 for Saturday)  
 

To get the GPS time, also the leap seconds must be taken into account (e.g. 13 leap 
seconds in 2004/2005).  
 GPS_Time (SOW) = INS_TIME (UTC SOD) + Day*24*3600 + 13 seconds [seconds] 

Attention:  The number of leap seconds will be increased at the January 1st 2006 from 
13 to 14! 
 

 

7 Odometer Logic 
The IMS has an optional interface to provide velocity information (more precise: 
distance travelled, measured by an incremental encoder mounted on the wheel).  

If the quantisation of the odometer is large (e.g. 4 cm / pulse) and the inertial sampling 
time is high (e.g. 2000 Hz), the virtual quantisation of the velocity is 0.04 m / 0.0005 s = 
80 m/s (see data log RAWVX). 

To avoid such virtual quantisation, the IMS also provides a precise measurement of the 
duration which is required for moving a reference marker on the wheel for a certain 
distance. To do this with an incremental encoder, we measure distance (RODO) and 
time (ODOT), and the result of the division is the required velocity as with floating point 
precision. 

If both RAWVX and RODO/ODOT are available, always the RODO/ODOT data are 
used. 
 

 

8 Coordinate System Definition 
The coordinate system of the data output of the iWP+ software is another than which is 
used in the standard iMAR navigator.  

8.1 Output Coordinate System 
The definition in the iWP+ software is as follows: 

iWP+ Definition: 
Consider the installation on an aircraft. The iWP+ coordinate system is directed with its 
x axis to the right, with its y axis to forward and with its z axis to upwards. 

o If you have a +ve roll rate, the right wing should lift itself up i.e. +ve roll angle. 
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o If you have a +ve pitch rate, then the nose of the aircraft should tilt up i.e. +ve 
pitch angle. 

o If yaw = 0°, the nose of the aircraft is pointing north 
o If yaw = 90°, heading (HDG, azimuth) is 270°, so t he nose is pointing west 
o If pitch is 20° degrees, the nose is supposed to b e pointing up. 

 
Other Definitions (e.g. ENU inside iMAR’s iNAV and iVRU navigators): 
Don’t be confused about different definitions! In other applications you will find e.g.:  

o NED convention (North, East, Down), where the x axis points forward, the y axis 
points right and the z axis points downwards: If yaw = 0°, the nose of the aircraft 
is pointing north and if yaw = 90° (also HDG = 90°) , the nose is pointing east. 

o ENU convention (East, North, Up), where the x axis points forward, the y axis 
points left and the z axis points upwards: If yaw = 0° (HDG = 90°), the nose of 
the aircraft is pointing east and if yaw = 90° (als o HDG = 0°), the nose is pointing 
north. 

  

8.2 IMU ����  Vehicle Transformation 
The iWP+ software expects that the IMU is mounted in the same coordinate system as 
it is defined for the vehicle: 

Sensor x axis  = right side 
Sensor y axis = front 
Sensor z axis = up 

If the inertial data inside of the raw data file are available in this coordinate system and 
the IMU raw data import filter in the iWP+ software is set to “x=right, y=front, z=up”, then 
the iWP+ raw data converter does not change any sign or permutation of the input data. 
I.e. due to this setting the data from the raw data file are read in the order x,y,z.  

To avoid any confusion, always this setting shall be used during the import of the inertial 
raw data! 
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Even if the IMU is mounted in another direction, it is highly recommended to use this 
setting! All misalignment or mounting angle adjustment can (and shall!) be done in the 
processing settings of the iWP+ software.3 

In the processing settings 3 angualr rotations can be defined (Eulerian angles) to 
transform the IMU coordinate system (as drawn on the housing of the IMU!) into the ve-
hicle coordinate system, which is defined as 

x_vehicle = right side (pitch axis) 
y_vehicle = front  (roll axis) 
z_vehicle = up  (yaw axis, if vehicle does not operate head-over) 

 

Example:  

The IMU is calibrated and mounted inside the aircraft that it deliveres the following data: 

 x = front 
 y = right 
 z = down 

                                            
3 Only and only if the raw data are not coordinated in a right-hand coordinate system, this shall be 
corrected by setting the propriate direction (e.g. Back instead of Front, if the y axis of the IMU is calibrated 
with negative sign). 
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i.e. the IMU shows a positive roll angle in NED coordinates (North/East/Down) if the air-
craft is standing on the airport runway. 
The z accelerometer measures -9.81 
m/s². 

We import the IMU data into the iWP+ 
software with the settings as described 
above: 

So no data are permutated and no sign 
of measurement vallues is changed 
during the import of the data. The data 
from the raw data file are used in the 
sequence x/y/z. 

Of course, the above mentioned co-
ordinate system of the IMU does not fit 
with the iWP+ definition – therefore it 
must be transformed into the iWP+ 
processing coordinate system which assumes x = right, y = front, z = up. To achieve 
this, the following setting 
is required: 

Take the IMU coordinate 
system (x = front, y = 
right, z = down), rotate 
first +90 deg around the 
IMU z axis and then 
rotate +180 deg around 
the IMU x axis. The total 
rotation leads to the 
iWP+ vehicle coordinate 
system (x = right, y = 
front, z = up). Insert the values of rotation into the “IMU Processing Settings”�  
Advanced. 

 

If the IMU is mounted inside the aircraft with 

 x = front 
 y = left 
 z = up, 
 
the transformation is  
 
 xRot = 0° 
 yRot = 0° 
 zRot = -90° 
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If the IMU is mounted inside the aircraft with 

 x = back 
 y = right 
 z = up, 
 
the transformation is  
 
 xRot = 0° 
 yRot = 0° 
 zRot = +90° 

  

8.3 Lever Arm   IMU ����  GPS Antenna 
Attention:  

The leverarm from the IMU to GPS is measured indepentenly from the real mounting of 
the IMU!  The lever arm is always measured in the vehicle’s coordinate frame! In this 
frame y directs forward, x is right and z is up. 

If the GPS antenna is mounted in front of the IMU (looking from the back to forward in 
the vehicle), the y value of the lever arm is positive.  

If the GPS antenna is mounted right hand site from the IMU (looking from the back to 
forward in the vehicle), the x value of the lever arm is positive. 

If the GPS antenna is mounted above the IMU (looking from the bottom to the sky), the 
z value of the lever arm is positive. 

 

8.4 Lever Arm   IMU ����  Odometer 
Attention:  

The leverarm from the IMU to the odometer (wheel sensor) is measured indepentenly 
from the real mounting of the IMU!  The lever arm is always measured in the vehicle’s 
coordinate frame! In this frame y directs forward, x is right and z is up. 

If the odometer is mounted in front of the IMU (looking from the back to forward in the 
vehicle), the y value of the lever arm is positive.  

If the odometer is mounted right hand site from the IMU (looking from the back to 
forward in the vehicle), the x value of the lever arm is positive. 

If the odometer is mounted below the IMU (looking from the sky to the bottom), the z 
value of the lever arm is negative. 
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A Coordinate System Definition 

A.1 System Configuration or iNAV-xxx  
Don’t read this section if you don’t use a iNAV-xxx. 

For accurate surveying and time synchronisation the 
external or internal GPS receiver has to provide a 
PPS signal and time information via an NMEA 
interface (to be connected to COM2 of the INS. The 
raw data of the GPS receiver (2nd port of the 
receiver) as well as the raw data of the INS (TCP/IP) 
shall be collected by an external computer (as an 
option the INS can be equipped with 4 GByte flash 
disk to store INS data or INS and GPS data). The 
DGPS post processing is performed inside of the 
total post-processing software. The post processing 
tool which provides the DGPS processing is called 
“InertialExplorer” which is a trademark of Waypoint 

Inc. (NovAtel Inc.) in Calgary and contains the well-known “GrafNav DGPS Processing” 
kernel. The InertialExplorer is provided by iMAR with a special interface to process 
iMAR data and is called iWP+. 

 

A.2 System Configuration or iVRU-xxx 
Don’t read this section if you do not use a iVRU-xx. 

All cables being used for connecting th iVRU to an L1/L2 GPS receiver are in the 
responsibility of the user (not subject of delivery).  

For accurate surveying and time synchronisation the external or internal GPS receiver 
has to provide a PPS signal and time information via an NMEA interface to the iVRU. 
The NMEA sequences of the GPS receiver (e.g. port 1 of the GPS engine) are fed into 
the VRU to determine the time of the actual PPS pulse and the raw data of the GPS re-
ceiver (e.g. RINEX or receiver specific format) are transmitted (e.g. via port 2 of the 
GPS engine) to an external data acquisition system to be collected there. The binary 
data of the iVRU are also transmitted to an external data acquisition system, where the 
data rate typically is 150 Hz. The following figure shows the wiring an the required Y-
adapter (as an example the usage of NovAtel’s OEM4 / OEMV-2/3 is shown). 
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The mode setting of the iVRU has to be adjusted to obtain the calibrated raw data (time 
stamp, acceleration, angular rate) in binary mode (float format, see manual of iVRU-xxx 
for details): 

 rs232 mode 2051 FFFF (see the VRU manual for details) 

The structure of the Y-adapter is as follows and assures, that the NMEA sequence 
GPGGA is sent with 1 Hz to the iVRU for time synchronisation (115.2 kBd). The binary 
data of the iVRU are sent to the data acquisition system from the same iVRU port 
(115.2 kBd): 
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The RX connector has to be connected via a cross-over cable to the GPS receiver and 
the TX connector has to be connected via a cross-over cable to the data acquisition 
system. The full RS232 connector (left) is connected via a cross-over cable to the iVRU. 

 

The DGPS post processing is performed inside of the total post-processing software. 
The post processing tool which provides the DGPS processing is called “InertialEx-
plorer” which is a trademark of Waypoint Inc. in Calgary and contains the well-known 
“GrafNav DGPS Processing” kernel. The InertialExplorer is provided by iMAR with a 
special interface to process iMAR data and is called iWP+. 

Before starting the post-processing of the data, the binary file obtained from the iVRU 
(*.VRU) has to be converted to a file format which is compatible to the NavCommand 
file format. This procedure is explained in the following chapters. 

If the data are collected with a Windows based computer, the terminal software 
iMTTTY.exe can be used to collect the iVRU data via RS232 (use an USB-to-RS232 
converter!). Because Windows is not a real-time operating system, it is necessary to 
start the iMTTTY software without any connection between the computer and the iVRU 
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(including starting the data storage on file) and then (not before!) the iVRU is allowed to 
be connected to the RS232 of the data acquisition computer. Otherwise the RS232 port 
of the Windows computer will generate many overrun errors which cause faults in the 
data acquisition (in this case a post-processing would not be possible). 

Turn-on Procedure: 

o Start the data acquisition of the GPS mas-
ter (reference) station. 

o Power-On the mobile (rover) GPS receiver 

o Power-On iVRU (connected to the GPS 
receiver, disconnected from data acquisi-
tion PC) 

o Start the data acquisition of the GPS data 
(use the receiver specific software or 
WLOG.exe) 

o Start the iMTTTY terminal software to col-
lect the iVRU data (115.2 kBd, N, 8, 1) 
and activate the storing of data to file 

o Connect the iVRU to the RS232 of the data acquisition computer 

o Wait at least 150 seconds before starting any motion of the vehicle 

o Perform your measurements 

o Have a standstill after your measurement for at least 150 seconds before stop-
ping the data acquisition of the iVRU data with the iMTTTY terminal program 

o Stop the data acquisition of the GPS data after stopping the data acquisition of 
the iVRU data. 

o Convert the iVRU data to NavCommand file format 

o Perform a post-processing with the iWP+ software. 

 


